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Introduction 
 

The purpose of this document is to help you to get up and running with Optimal;. Optimal; is 
the application environment from Optimal Answers LLC that operates in an internet browser.  
Common features of Optimal Answers applications include: 
 

• An SQL database that is the repository for data 

• A mathematical model that uses that data to optimally solve business problems 

• A repository for solutions to previously solved instances. 
 
Optimal; is the “User’s Interface” for numerous Optimal Answers applications.  The 
applications are not discussed in this document.  Optimal; provides the means to: 
 

• View data tables.  Left-click a table name in the Data menu to display the table.  In the 
web interface, tables are displayed one screen at a time.  Scroll left and right up and 
down with a familiar scroll bar or move up and down by selecting the page to view.  
One of the features of Optimal; is the ability to create and save custom table layouts 
(views) to suit your personal preferences and to meet your changing needs. 

• Update data tables.  Records can be added, edited, copied, and deleted. The Import 
feature conveniently adds new records and updates existing records with spreadsheet 
data.  Export copies data from the database to external files to support other 
activities. 

• Execute Optimal applications.  Optimal applications extract data from the database, 
create and solve a mathematical model, and send the results back to the database. 

• View the solution.  Typically, the results are viewed two ways.  Solution results tables, 
one for each class of variables, provide a condensed view of the answer.  SQL solution 
reports are formatted views of the solution. Solution tables and reports can be 
exported. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
Microsoft, Visual Studio, SQL Server, SQL Server Integration Services and SQL Server 
Reporting Services, and Windows are registered trademarks of Microsoft Corporation.  
 
Document version is as of October 28, 2024.  
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How to Access Optimal  

 
Link to Optimal:  https://app.optimalanswers.com/ 
 
Log In: Click Log In at far right of page header; in the Log In form, supply your Email and password 
and click the Log in button. 
 

 
 

Alternatively, you can be automatically logged in via SSO authentication. Contact Optimal Answers for 
details. 

 
 

Useful Browser Features 
Working in a web-browser environment can benefit from all the available browser features, e.g.: 

• Multiple browser tabs. An Optimal database can be open in multiple browser tabs simultaneously. 
Once you have signed into Optimal; and opened your database, open other browser tabs by right-
clicking the Optimal icon in the upper-left-corner of the page and selecting “Open link in a new 
tab”. This lets you quickly move back and forth between different parts of the application by 
moving from tab to tab. 

• Quick zoom. Ctrl+ and Ctrl- immediately zooms in and out based on your immediate needs. 

  

https://app.optimalanswers.com/
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Begin Session 
 
When you log in, what you see depends on whether this is your first session or not. 
 

First session.  Click your Email address in the page header to get the “Select an Application” screen as 
seen in the screenshot below. 

 
Click Application to get the list of application databases. 

o Click your choice. 
o Click Select Application to open the application. 

 
Not first session.  The name of the application-database in use and the table that was open when you 
ended the previous session is in the page header, as seen in the image below.   

 
If this is the application to be used in this session, continue with the session.  Otherwise, click the 
application-database name to get the “Select an Application” screen 

 
 

Select / Change Application.  If “Select an Application” screen is not open, click your email address or 
the application name to open it.  Click the down-arrow at the right of the Select an Application box to 
get the list of application databases . 
 

o Click your choice. 
o Click Select to open the application. 

 
In either case, if you have 10 or more application databases assigned to you, a Search Filter box is 
present; type an application name filter to show only those applications whose names include the filter. 
If you have only one application, it is automatically selected. 
 
A list of filters that have been used previously is displayed from which you can select the filter to use. 
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Function Area Menus 
 

 
 
After the application is opened, there are typically four function area menu tabs in the page header: 
 

Function Description 
Data Review, edit, and manage data tables 

Opt-It! Create and edit control information for model instance and invoke the solver 

Solutions View results and reports  from previously solved instances 

Administrative Security and utility  
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Data 
 
 
The Data Menu is a list of data tables you can review and 
manage.  Some items in the list have a gear symbol appended; 
these items are Action Buttons used to initiate the named 
action (e.g., Import).  

• Click the right-arrow (˃) sign at the left of table name to 
expand the list at that table.  

• Ctrl-click any right-arrow (˃)  sign to expand the entire list 
of table names 

• Click the down-arrow (˅)  sign at the left of table name to 
collapse the list at that table.   

• Ctrl-click any down-arrow (˅) sign to collapse the entire list 
of table names 
When the list opens, it is expanded to two levels. 
 
Click a table name (e.g., Formula Items) to display that table.  In 
order to get as much of the table on the screen at one time, the 
table occupies the full width of the screen, thereby overlaying 
the list of data tables.  To display another table, restore the 
Data menu by clicking Data in the menu-bar. 
 
 
 
 

 
The application database has tables that are designed for a specific application. Shown here is the list of 
database tables in the Formulation application.  You will add, edit, and delete records in these tables, but 
you will not add or delete tables. 
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The DATA screen head shows the name of the application-database and the name of table being displayed. 
 
Above the table is a row of icons, the menu of data table functions (hover over an icon to get a brief 

description of its function) 

 

Icon Function Operation 

 
Add new row manually input data for a new record (row) in this table.  

A new, empty  row appears as the first row on the screen. 

 
Copy Copies selected row/rows as new row/rows. 

A copy of the selected records appears at the top of the on-screen table. 

 
Clone Clones selected row. 

A copy of the selected records appears at the top of the on-screen table. 
F the table is an entity-list (e.g., the list of lot-sets) only one record can 
be cloned and related data are also copied. See: Cloning 

 Delete Deletes selected rows. 
The selected record(s) are deleted. Deleted records are colored red data 
in deleted records are marked with a horizontal slash 

 
Update database Applies data edits to database table. 

Apply all changes to the on-screen table to the database table. 

 Cancel edits Cancels data edits. 
Abandon all on-screen table changes. The on-screen table display is 
restored to its initial condition and the database-table is unchanged. 

 Auto-size Columns Set width of columns to fit contents of head and cells. 
The width of all columns of the on-screen table are adjusted to be wide 
enough for maximum length of data in that column including the header. 

 Choose Columns Specify which columns are displayed. 
A selection-list appears; you can either select all columns and turn off 
the ones you don’t want or deselect all and turn on the ones you want. 

 Search Selects all rows that have the search-key in any field. 
Search all cells of the entire table for the text in the box (search key). 
Display all records that contain the search-key. The search is not case 
sensitive. 

 Layout menu Opens the Layout menu. 
Activate the Layout feature by opening the Layout panel. See: Layouts 

 Decrease Freeze Removes the right-most frozen column from Freeze-columns. 
Decreases the number of frozen columns by one 

 Freeze control Deactivate/activates Freeze-columns. 
If a table is wider than the screen, when scrolling to the right, leftmost 
columns scroll off the left edge of the display. Freeze keeps the specified 
number of leftmost columns on the screen. Freeze-control toggles the 
feature on/off. Moving a column into/out-of the frozen area 
freezes/unfreezes that column. 

 Increase Freeze Adds the left-most unfrozen column to Freeze-columns, activates Freeze. 
Increase the number of frozen columns by one, starting with the 
leftmost unfrozen column, when the first frozen column is turned on, the 
frozen feature is activated. 

 Print Prints one page of the upper-left-corner of the on-screen table 
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Export to excel Exports current table in Excel format to Downloads/table-name.xlsx 

1. Rows and columns exported are same as entire on-screen table. 
Thus, if Choose-Columns/filters has removed columns/rows from 
the display, they are not in the spreadsheet. 

2. The order of the rows/columns in the spreadsheet are the same 
as in the on-screen table  

3. The spreadsheet columns are the same width as the on-screen 
columns 

 Export to PDF Exports current table in PDF format to Downloads/table-name.pdf 

 Show in Pivot Table Displays table as a Pivot table. 
See the Pivot Table section 

 
Import into this table Opens the Import tool with “Database table to update” set for this table. 

See the Import section. 

   

 
 Any change made to the displayed table (edits, copies, deletions, …) are made to the display only. The table 
in the database is not changed until requested by the user. 

• Click “Update database” to apply all changes to the on-screen table to the database table. 

• Click “Cancel” to abandon all on-screen table changes 

• Any time you leave a screen with un-applied changes, Optimal asks if you want to update the 
database or abandon the changes. 
  

Table Display 
 
Tables are displayed in normal form; each column of the display is a table field or attribute; each row is a 
record.  At the bottom of the table display is a horizontal scroll-bar for moving right and left through the 
table columns.   
 
Modifying the table display (as opposed to modifying the table contents) helps by organizing the data so it 
is easier to work with and it is easier to find the information of interest. 
 

The Items per page box 
The Items per page box at the bottom of the table display accommodates customizing the number of 
records from tables to display at one time.  If the number of entries specified exceeds what fits on the 
screen, a vertical scroll-bar is provided.  Click the down-arrow to get a selection of the number of rows to 
display per page, including “all.” 

 
 

If Items per page is selected and the number of items in the table is too many to fit on the screen, a vertical 
scroll-bar is on the right of the screen. 
  
If Items per page is other than All and the number of records in the table is more than the selected number 
of entries to show, there is a familiar page selector for moving up and down through the pages of the table. 

 
Also, at the lower-right corner of the screen is information about the size of the table. If the table has been 
filtered, this is the reduced, filtered size of the table. 
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Performance note. If a table has more than a few hundred rows, specifying Show All entries might cause 
loading that table to take a relatively long time. The interface has been tuned to load a relatively small 
number of records quickly. Your choice of the number of records to load at a time can be a major factor in 
your satisfaction with the use of Optimal. 
 

Sorting Columns 
At the top of each column in the display is the column name; to the right of the name is a sort-symbol if the 
column is sorted, either an up-arrow to indicate ascending order, a down-arrow  to indicate descending 
order, or neither to indicate original order.   

 
 
In the sample, above, the Lot Set and Item Name columns are sorted in Ascending order. Additionally, we 
see a 1 and a 2; they indicate that the Lot Set column is the primary sort field and Item Name column is the 
secondary sort field. 
 
Click anywhere in the column-name box to sort the column – entire records are moved when the column is 
reordered; all records in the table are involved in the sort, not just the records being displayed.  Four 
alternatives are: 
 

1. Click an unsorted-column name box to sort the column in ascending order. 
2. Click a column name box a second time to sort the column in descending order. 
3. Click a column name box a third time to restore the column to its original order. 
4. Ctrl-click a column name box to sort that column as a secondary sort relative to another column or 

other columns that are already sorted. 
 

Filtering Records 
Filtering is a technique for selecting which records from the table are displayed. Filters apply to all records 
in the entire table. 
 
How to Use a Filter - Alphabetic Field.  At the top of each column in the display is a funnel shaped icon; 
click the funnel to activate the filter menu for that column. Filter actions are: 

• Sort A to Z reorder the table such that entries in this column are in ascending order 

• Sort Z to A reorder the table such that entries in this column are in descending order 

• Clear Filter remove this column’s filters 

• Text Filter opens the Text Filter submenu which has the following options 
o Equal - selects rows that have only the specified text in the column 
o Not Equal  -selects rows that do not have only the specified text in the column 
o Starts With - selects rows that have the specified text at the beginning of the entry in the 

column 
o Ends With - selects rows that have the specified text at the end of the entry in the column 
o Contains - selects rows that have the specified text anywhere in the column 
o Does Not Contain - selects rows that do not have the specified text anywhere in the column 
o Custom Filter – opens Custom Filter window 
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Selecting any one of the Text Filter options opens the Custom Filter window where the “specified 
text” is entered. 

• Selection List- The remainder of the menu is devoted to a selection-list of unique entries in this 
column: 

o Search – enter into the search-box word-parts for entries you want in the selection-list; 
click the spyglass icon to get the subset of entries in the selection-list. 

o Select All – Set the mode for selection: 
▪ If Checked – All entries are selected to be displayed (all check-boxes next to the 

name in this column are checked)  and clicking entries in the selection-list turns 
them off. 

▪ If Unchecked – All entries are selected to not be displayed (all check-boxes next to 
the name in this column are unchecked) and clicking entries in the selection-list 
turns them on. 

o The Selection List – A list of unique entries in this column (might be subsetted by Search). A 
vertical scroll-bar is present if appropriate. 

• Click OK to activate the filter 
 As many columns as appropriate can be filtered. 
 

 
 
The Custom Filter box allows compound filters where two conditions can be ANDed or ORed 
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How to Use a Filter - Numeric Field. Filtering a numeric field is based on simple numeric relationships 
relative to the numeric value in the field, regardless of how the number appears.  

 
 
Filtering a numeric field is similar to filtering an alphabetic field except for the action of the 
Numeric Filters: 

o Equal - selects rows that have the specified value in the column 
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o Not Equal  - selects rows that do not have the specified value in the column 
o Less Than -  selects rows that have a value less than the specified value in the column 
o Less Than or Equal - selects rows that have a value less than or equal to the specified value 

in the column 
o Greater Than -  selects rows that have a value greater than the specified value in the 

column 
o Greater Than or Equal - selects rows that have a value greater than or equal to the specified 

value in the column 
o Between - selects rows that have a value between the two specified values in the column 

 
How to Use a Filter - Date-Time Field. Filtering a date-time field is based on relationships relative to the 
date-time value in the field. It is similar to filtering alphabetic and numeric fields and is not discussed in 
detail here. 

 

Grouping Records 
Across the top of the table display is a strip with the caption: 

 
• Drag a column-header onto the Group-strip: 

o The column is deleted from the display. 
o In the first column of the display is an entry for each unique entry in the grouped column: 
o To the right of the entry is the message – xxx items where xxx is the number of records with 

this entry value. The remainder of that row is empty. Following are the xxx rows for that 
entry. 

o To the left of the entry is a down-arrow. Click the down-arrow and the xxx records for this 
entry disappear and the down-arrow is replaced with a right-arrow. Click the right-arrow to 
replace it with a down-arrow and the xxx records re-appear. 

• Drag other column-headers onto the strip to get subgrouping of the display. 
 
If a column has been filtered prior to being grouped only those entries that survived the filtering are 
grouped. 

 
Freeze Columns  
 
Freeze Columns keeps the specified number of left-most columns on the screen as the remaining columns 
are scrolled left and right.  Click: 

 Decrease Freeze Removes the right-most frozen column from Freeze-columns. 
Decreases the number of frozen columns by one 

 Freeze control Deactivate/activates Freeze-columns. 
If a table is wider than the screen, when scrolling to the right, leftmost 
columns scroll off the left edge of the display. Freeze keeps the specified 
number of leftmost columns on the screen. Freeze-control toggles the 
feature on/off. Moving a column into/out-of the frozen area 
freezes/unfreezes that column. Frozen columns are shaded. 

 Increase Freeze Adds the left-most unfrozen column to Freeze-columns, activates Freeze. 
Increase the number of frozen columns by one, starting with the 
leftmost unfrozen column, when the first frozen column is turned on, the 
frozen feature is activated. 
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o If columns have been removed from the display via Column Visibility, they are not included 
in the freeze columns count. 

o To edit data in a frozen column, first unfreeze the column. 
o Column names of frozen columns are shaded 

 
 

Choose Columns to Display opens a window with a list of the column names for this table.  
This comprises a selection-list of column names of this table: 

o Search – enter into the search-box column name beginnings for columns you want in the 
selection-list; click the spyglass icon to get the subset of entries in the selection-list. 

o Select All – Set the mode for selection: 
▪ If Checked – All columns are selected to be displayed and clicking columns in the 

section-list turns them off 
▪ If Unchecked – All columns are selected to not be displayed and clicking columns in 

the section-list turns them on 
o The Selection List – A list of column names in this table (might be subsetted by Search). A 

vertical scroll-bar is present if appropriate. 
Click OK to activate the selection. The table in the database is not disturbed, the only effect is on the 
display. This selection persists until it is changed.  
 
A word of caution: be aware that the table on the database contains data you are not seeing, so don’t 
remove data from your view unless it is safe to do so. 
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Layout Menu 
Once the display of a specific table has been set up as desired, that view of the table can be saved so that 
the table can be switched to that layout.  For each table, as many different layouts can be saved as desired.  
Each saved table layout is assigned a name to facilitate recalling the layout.  When a layout is saved, its 
name is associated with the table, so the same layout name can be used for multiple tables. 
 
Once activated, the Layout menu remains on the screen until: 

o The Layout icon is clicked (The active layout remains in effect) 
o Another table is opened 

 

 
 

Create Layout 
Creating a layout is a 3-step process once the desired view has been set up: 

o If the Layout menu is not present, click the Layout icon to obtain the Layout menu 
o Click Save As. 
o Type the desired name in the dialog-box and click OK. Assigning meaningful names can help 

selecting the appropriate layout to use. 
 

 
 

 

Apply Layout 
If no layouts have been saved for this table, the Apply Layout button is greyed out.   

o If the Layout menu is not present, click the Layout icon to obtain the Layout menu 
o Click the down-arrow in the name box to get a list of available layouts for this table 
o Select the desired layout and click Apply 
o Type the desired name in the dialog-box and click OK. Assigning meaningful names can help 

when selecting the appropriate layout to use. 
 

Update Layout 
If, after a layout has been applied the view is modified, the existing layout can be replaced by the new view.  

o Click Update 
 

Rename Layout 
The current layout can be renamed. 

o Click Rename 
o Type the desired name in the dialog-box and click OK.  

 

Delete Layout 
The current layout can be deleted. 
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o Click Delete 
 

Clear Layout 
The effects of the current layout are dropped and the grid is restored to its unmodified view. 

o Click Clear 
 

Global Layouts 
A layout belongs to the user who creates it. However, if, at the time the layout is created the Global switch 
is on, the layout is available to all users of the database. 
 

Copy Layout 
There is no Copy button, but copying is easy. 

o Apply the layout to be copied. 
o Click Save As. 
o Type the desired name in the dialog-box and click OK. 

 

Display Persistence 
Once the view of a table is established, i.e., the tables layout, sorts, filters, column selection, etc., if leaves 
that table and subsequently returns to it, the display returns to the view that was active the last time the 
table was being displayed.  

• Display persistence for all tables is abandoned when: 
o A different database is opened 
o The application is closed 

• Display persistence for a table is abandoned when the active layout is cleared 
 
To restore a table view in subsequent session, save the view as a layout. 
 

Data Table Update Functions 
 

Selecting Rows to Copy, Clone, Delete, etc. 
 
Selecting rows applies to the current page only, not the entire table. If it is desired to work with the entire 
table, change the “Items per page” selection to “All”. For efficiency, return it to its initial value when 
finished. 
 
At the far-left of the table display is a column of row-select check-boxes. If a check-box is checked, the row 
is selected; otherwise, it is not selected. In the header (column name row) is a master check-box. Click it to 
check all rows; if it is on, click it to uncheck all rows. 
 
Click, Cntrl-click or Shift-click a row-select check-box to reverse its status, (i.e., check becomes uncheck and 
uncheck becomes check) without affecting the status of any other row-select check-boxes.  
 
To select rows by clicking in the table grid, Right-click anywhere in the grid and select “Row select mode”, 
then: 

• Left-click anywhere in a row to select that row. This action de-selects any rows previously selected. 

• Ctrl-click anywhere in a row to add that row to the set of rows already selected  

• If a row is selected, Ctrl-click anywhere in the row to de-select it 
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• Shift-click anywhere in a row to add that row plus all rows between it and the most recently clicked 
row to the set of rows selected. This action de-selects any rows previously selected. 

 

Editing Data in Grid 
Manually entering  and modifying data in the grid is done as follows: 
Selecting a cell to edit: 

• Double-click a cell – the cell expands and the cursor is placed in the cell, 

• Tab. When finished in a cell, press Tab to move to the next cell to the right and open that cell for 
editing, 

• Enter. When finished in a cell, press Enter to move to the next cell below and open that cell for 
editing, 

Edit a numeric or text cell: 

• Position the cursor to where additional characters are desired and start typing, 

• To replace current content, select the characters to be replaced (usually the entire contents) and 
start typing, 

Edit a Look-up cell. If a cell type is look-up, there is a down-arrow present: 

• Click the down-arrow to get a selection list of valid entries for this cell, 

• Start typing the desired entry for this cell; the same selection list appears, but it is positioned at the 
characters you have typed, 

• At the end of the selection list is a blank entry. Click the blank entry to insert a blank in the cell. 
Entering data in correlated fields. Some data fields are related, such as product codes and product names. 

When entering data, you may enter either one or the other (e.g., the code or the name) and 
Optimal automatically fills in the other. The automatic fill does not occur immediately; it happens 
when the database table is updated and you do not see the result until the table is reloaded. 

 
A cell that is changed: 

• Is colored green 

• Hover over a changed cell to see the original value 

• Click Update to record all grid changes on the database 

• Click Cancel to abandon all changes and restore the display to the database version 
 

Grid Right-Click Menu 
Right-click a cell in the grid to get the grid right-click menu: 

 
If the cell clicked is a look-up or check-box type cell, the menu does not include Copy, Cut, Clear, or Paste. 
Scroll to Column. A list of column names for the current table appears, in alphabetic order, with a scroll-bar 
if appropriate. Click the desired column name and the display is positioned with the selected column in the 
center of the screen, horizontally. 
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Row Select Mode. In this mode, if a cell or cells are clicked, the rows containing the selected cells are 
selected. See Selecting Rows to Copy, Clone, Delete, etc. 
 
Column Select Mode. In this mode, if a cell or cells are clicked, the status of the cells are reversed 
(unselected become selected and selected become unselected). 
 
Copy. The contents of the clicked cell are placed in the clipboard. If the right-click encompasses more than 
one cell (i.e., a cell is clicked and the cursor is dragged across multiple cells before the click is released), the 
cell under the cursor at the release is copied to the clipboard. 
 
Cut. The contents of the clicked cell are placed in the clipboard and the cell is cleared. If the right-click 
encompasses more than one cell (i.e., a cell is clicked and the cursor is dragged across multiple cells before 
the click is released), the cell under the cursor at the release is copied to the clipboard and that one cell is  
cleared. 
 
Clear. The clicked cell is cleared. If the right-click encompasses more than one cell (i.e., a cell is clicked and 
the cursor is dragged across multiple cells before the click is released), all cells included are cleared. 
 
Paste. The copy or cut has captured the value of a single cell. That value is pasted into t cel or cells 
highlighted by the right-click. If the right-click action incudes a check-box cell, when the numeric value is 
greater than zero, the cell is checked; otherwise, the cell is unchecked. 

 
Add Records  
Click + to add a new, empty row at the top of the current grid-display. 
Add data to this row as appropriate. 
 

Copy Records 

Click  to copy the selected row or rows. 

• The new row(s) appear at the top of the current grid display, 

• Edit the new row(s) because when the table is updated to the database table, rules that prevent 
duplicate identifiers are applied and duplicate rows might be eliminated, 

• Click the Update icon to save the changes, 

• After the Update the new rows might no longer be at the top of the display; they take their place 
within the table based on the currently active table view. 

 

Clone Records 

Click  to clone the selected row or rows. 

• The new row(s) appear at the top of the current grid display, 

• Edit the new row(s) because when the table is updated to the database table, rules that prevent 
duplicate identifiers are applied and duplicate rows might be eliminated, 

• Click the Update icon to save the changes, 

• After the Update the new rows might no longer be at the top of the display; they take their place 
within the table based on the currently active table view (e.g., sorts, grouping, …). 

 

Enhanced Clone Functionality.  Some Optimal applications have enhanced functionality associated with 
Clone.  In some cases, when a new member is added to a domain by cloning an existing member, much of 
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the data related to the existing member is replicated for the new member. For example, in our Formulation 
family of applications, if a formula is cloned, records are added to related data tables that are identical to 
the records for the cloned formula, but with the new formula identifier.  Consult the application 
documentation for details. 
 
 

Delete Records and Cell Contents  

Click  to delete the selected record (or records) and/or contents of selected cells from the display table.  
Left-click a record to select it and click Delete.  You are asked to confirm the delete request.  Select multiple 
records to delete all selected records at one time.   

• The records and cells deleted in the display are colored red and all data in deleted records and cells 
are crossed out, 

• Data in the database table are not deleted until the Update icon is clicked, 

• Click Cancel icon to restore all display changes, 

• Click Update to save all display changes to the database table. 
 



 
 

© 2015-2024 Optimal Answers LLC Optimal User Guide Page 20 

Opt-It! 
 
The Opt-It! Menu is where selections are specified relative to which sets of data to use, runtime options are 
set for this instance of the model, and the optimizer is invoked.  The menu includes the model-oriented 
action-button, Solve, and application specific model-oriented tables.  

 
SOLVE is a standard feature of this menu.  Click Solve to: 

• Export data from the application database to the model space. 
o If the application has a Selections table, it is opened to display all run specifications; click 

the Opt-It! button on the desired row of Selection to initiate that run, The Selections table 
must be set up prior to Clicking Solve 

o If the application does not have a Selections table, the solve step begins. 

• Invoke the application software to create and solve the appropriate mathematical model. 

• Import model solution results into the application database. 
 
The tables available in the Opt-It! menu are application specific.  For example, the table names seen here 
are specific to Optimal Formulation, Optimal Yield, and Product Development applications. 
 
The steps required to execute the solve are model dependent.  Refer to the application documentation for 
details.  Typically, there are three things to do: 
 

1. Verify that the run-time options are appropriate for this run.  In some applications, runtime options 
are in the table named System Reference (Options tend to be relatively static). 

2. If there is a Selections table, verify that it contains a record that specifies the run to be made. 
3. Click Solve (and choose the desired run from the Selections table, if required). 

 
After initiating Solve, open the Solution menu and select Solution Results to track the progress of the run. 
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Solutions 
 
Use the Solutions Menu to view results from previously solved instances using this application. 
 

Each time an application model is created and solved, it is assigned a 
Run-Sequence ID Number.  All results relative to that run are tagged 
with the run-sequence number.  Results from each previously solved 
instance of the model are retained until its run-sequence number is 
deleted from the Run Sequence table. 
 
The Solutions Menu includes two action-buttons, Reports and Solution 
Results, and a list of application-specific solution results tables. 
 
Three levels of results information are available. They are selected from 
the Solutions menu. 
 

Reports invokes the SQL report server to display formatted reports for 
any previous solutions.  The report server presents a list of available 
reports for the application being run.  Left-click a report name to create 

the report.  See the application documentation for details. After viewing a report, click the back-arrow to 
return to the report-list; click Optimal to return to the application screen. 
 

Solution Results displays the solution status of each run on this model database and provides access to a 
set of files associated with each run. The table opens sorted by run number, with the most recent run at the 
top. 
 
The Solution Results table has a record for each run with: Run Sequence ID Number, Status, Date of Run, 
User ID, model-specific information, and a column named Model Logs.  
 
Run Status 
The Status column of the Solution Results table shows the run status while it is running and the completion 
status after it has finished. Completion status wording is application dependent, but generally conforms to 
these standard interpretations. 

Status Interpretation 

Run Status 

Solving Model is being created and solved 

Processing Solver has finished and results are being imported into the database 

Completion Status 

SUCCESS Solver successfully obtained an optimal solution 

SOLVED Solver obtained a solution that is within the user-specified tolerance of the 
theoretically best mixed-integer solution. This is likely a very good result. 

COMPLETE Solver obtained the best integer solution it could within the user-specified limit on 
the number of mixed-integer branch-and-bound nodes – see Application Log 

NOINT Solver was unable to find an all-integer solution to this model instance 

INFEAS Model has no feasible solution – see Error Log 

ABORT Model run has aborted – see Error Log 

FAILURE Model run has failed – see Application Log 
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When the status changes (e.g., from Solving to Processing) the status box is yellow for a brief period. 
 
Model Logs 
In the Model Logs column is a link (Model Reports) to a set of files generated by the run; click the hyperlink, 
Model Reports, for the run of interest to get the list of files.  This set of files is retained until the run is 
deleted from the Run Sequence table. 
 
Most of the files are formatted text created by the application and the underlying software. These files are 
likely to be of little interest (except Application Log, Error Log, and Warning Log).  However, if the model 
fails to solve and the reason is not immediately obvious, this set of files could be invaluable in the process 
of diagnosing the problem.   
 
Click a file name to open the file in a pane to the right of the screen. 
 

To the right of the file name is a down-pointing-arrow in a circle, ; click it to download the file to where 
your browser is set to download files 
(browser settings). 
 
The text-display software supports familiar 
basic paradigms: 
 - Cntrl F  find 
 - Cntrl end  go to end-of-file 
 - Cntrl home go to beginning-of-file 
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Model Results Log Files 
Optimal; File name Function 

Application Log MPSIII run log 

Error Log Error messages 

Feasibility Analysis Infeasibility analysis messages 

Input Issue Log Log file with record of issues encountered while reading data from SQL 

Model Act File (Binary) MPSIII file that holds tables, matrix, & solution for this instance (binary) 

Model Result (coded) Results being passed back to SQL (encoded text) 

Output Issue Log Log created by interface while reading results 

Recursion History History of price-conversion steps (Formulation only) 

Report Formatted text report if produced by application 

Run Data (coded) Data passed from SQL to DATAFORM (encoded text) 

Warning Log Warning messages 

 
 

 
Solution Result Tables.  The list of results tables is application specific.  The 
tables listed here are SQL database tables that are the source of results 
data for the SQL Report Server report.  They can be used for any purpose 
including exporting and simply viewing the results.  Shown here is the list 
of Food Product Development results tables. 
 
Results tables are read-only.  Table viewing and layout features described 
for data tables apply equally to solution tables. 
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Administrative 
 
With the Administrative Menu authorized users can manage database security, SQL Report Server database 
access, and table column configuration. 
 
Database Security is not discussed here.  It is the responsibility of your database administrator and by its 
nature is not shared.  Tools accessible to administrators (provided by Optimal Answers) include: 
 

• Users – a list of user IDs of those with permission to access this database. 

• Security Group – assignment of access authority by user type. 

• Node Group Security – assignment of access authority to specific tables. 

• Attribute Group Security – assignment of access authority to specific table columns. 

• Node – specifies access to tables by all users 
 
Configuration Information is information used by the SQL Report Server: 
 

• Company Name is text placed as the header of reports created by the SQL Report server.  It can be 
any text. “Company Name” is just a suggestion. 

 

• Report Folder Name. Each Optimal application has its own folder of SQL reports.  This field comes 
populated with the name of the folder for the application; the name of the folder should not be 
changed. 

 
 
Configure Columns action button is used to add, remove, or modify columns in any table. Caution is 
required in using this feature; you are limited in what changes can be made as explained below. 

 
 
For the selected table, you have the choice between “Create a Column” and “Select a Column” to modify.  
 
Create a Column opens an Add an Attribute form in which the specifications for the new column are 
provided: 
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• Name serves two purposes; it is both the display name and the database attribute name.  In the 
case where the data in this column are exported to the model, the name attached to this element is 
arbitrarily created by Optimal;.  Therefore, data with specific names required by the application are 
not added to data tables using this feature.  In the exceptional case, such as the Optimal 
Formulation Lots table, where the table has extendable attributes, data columns for the application 
can be created using this feature. 

• Display Format is the same as above. 

• Data Type Click the down-arrow for a selection list that includes: Text, Whole Number, Decimal 
Number, Date, and Check Box (True, False). 

• Character Limit If the data type is Text, the character limit box appears.  Enter the maximum 
number of characters for this field. The default maximum is 24. 

• Calculation Field If this field is to be exported to the application to be included in the optimization 
model, check the Include box. 

 

Select a Column, is activated when the column name is supplied.  

 
One or two buttons are offered depending on the column selected: 

• Edit Column – offered for all columns 

• Delete Column – If this is a required column for the table and has the Disable Delete flag turn on, it 
can’t be deleted; in this case the Delete Column button is not offered 

 
The Edit Column button opens an Edit form; for example, the Block Size column of the Item Usage Report 
table: 
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Only two fields are accessible for modification (the other two cannot be changed and are greyed-out): 
 

• Name is the display name, i.e., the name of the column that is seen when the table is displayed; the 
name by which the column is known to SQL and to the application remains unchanged. 

• Display Format specifies how the values in that column appear on the screen.  Format codes 
available depend on data type.  For example: 

Data type Format code Result 

Decimal Nn Whole number part with comma separators every 3 digits from the 
right, a decimal point, n digits to the right of the decimal point 

 Cn Same as Nn, but preceded by a currency symbol ($) 

DateTime G mm/dd/yyyy hh:mm AM/PM 

 

The Delete Column button requests confirmation that the delete is desire; if confirmed, the column is 

deleted. 
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Importing Data 
 
Optimal; supports import of Microsoft Excel spreadsheet data into the application database tables.  
Optimal Answers provides excel spreadsheet templates that are a significant aid in getting the spreadsheets 
set up correctly for Import.  Alternatively, if you Export a table from Optimal; to Excel, the spreadsheet 
created is a standard xlsx file in the correct format for Import into that table. 
 

The Spreadsheet 
 
Optimal Import processes a standard xlsx file. 
 

o If the specified xlsx file has multiple sheets, any sheet can be imported. 
o The first row of the sheet to be imported contains the names of the field (attribute) in each column. 
o The column names in the sheet should be identical to the attribute names of the database table.  If 

not, the automatic mapping of spreadsheet columns to SQL table fields cannot work for those 
columns and the mapping is done manually. Manual mapping works; however, it could be tedious 
and time consuming. 

 
For example, here is a fragment of a Formula Items table from Optimal Formulation: 

 
 

  



 
 

© 2015-2024 Optimal Answers LLC Optimal User Guide Page 28 

Executing Import 
 
Click the Import icon in the Data toolbar to import into the current table or click the Import action button 
(at the top of the list of tables in the DATA menu), to get: 

 
 
To get started, provide the information requested in the upper left: 

• Database table to be updated. Click the down-arrow to get a list of tables in the database; select 
the table from the list. 

• Excel file to Import. Automatically populated with the last file imported. Click Browse to get a 
standard browse window and browse to the .xlsx file to import. 

Click Load 
If the Excel file has only one sheet, that sheet is loaded into the Import workspace. 
 
If the Excel file has more than one sheet, when you click Load, Import displays a new dialog-box from which 
you select the sheet to be used: 

 
Select the worksheet to use 
and click Load Sheet. 
 
 
 
 
 
 
 
 

 
Import populates 4 of the boxes on the screen: 

• Columns to Match for Update 
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Records being imported could be either updates to existing records 
or new records. In the definition of each table, the fields that are 
unique record identifiers are specified. If an incoming record has 
the same values in all the unique identifier fields as an existing 
record, data in the incoming record replace data in the existing 
record – fields not in the incoming record are unchanged. 
Otherwise, the incoming record is added to the table. 

 
Import fills this box with the list of unique identifier fields for the current table. 
 

• Imported Column to Database Column 

Initially, this shows which imported columns are mapped 
into which columns of the database table; this is done 
automatically based on matching names. 
 
 
 
 
 
 

 

• Import Columns and Database Columns 
This pair of tables show the columns 
in the import and the database table 
that have not been paired up. It is 
acceptable to have unpaired column 
names; those columns are ignored. 
 
In this case, it appears that Item 
should be paired with Item Name.  
 

One way to fix this is to edit the Excel file to have a matching column name; after which, click the Reload 
button to load the modified spreadsheet. Alternatively, left-click the import column name (e.g., Item) and 
drag it atop the database column name (e.g., Item Name) to which it is to be mapped. The names disappear 
from these boxes and appear in the Imported Column to Database Column box. 
 
The All button toggles on and off the list of all column names in the database table. 
 
Two buttons are available: Validate, and Import. 
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Validate performs an import without making any changes to the database table. The purpose is to detect 
any mistakes that would prevent a successful import. Errors detected are displayed in the Output window.  
 
In the sample run, a Customer Order Items table from a different database was used and none of the 
incoming item names match the items in the database. Validate Filled the Output box with details of what 
is wrong. The beginning and ending of one message is: 

Items [ choice blade meat 109b, choice brisket 120, cho  …  loin, utility 1 trimmed flat ] in 

the Item column are not found in the Item table's ItemName column. 

 

Errors detected must be resolved before continuing. 
 
When Validate is satisfied that the import will be successful, it says so. 
 

 

 
Import imports data from the spreadsheet into the database table. When finished, Import sends a brief 
summary to Output: 

 

• The database table has 190 new records 

• 5 previously existing records were modified 

• Import was successful 
 
 

 

Merging Default Values during Import 
 
Merging default values is a feature of Import that applies only to the Lots table in the Formulation, Yield, 
and Product Development databases. Typically, it is used to populate the nutritional and physical attributes 
with default values for lots of an item. If: 

• The table being imported into is Lots 

• A field in the imported record is null, i.e., the field does not exist in the .xlsx file. 

• A DEFAULT lotset exists, the default lotset contains a record for the Item in the import record, and 
the field is not null 

then 

• The value in that field in the default record is inserted into the field in the imported record. 
 
Be aware that an empty field in an Excel record is interpreted as zero, not null. An easy way to have a null 
or non-existing field is for the field (i.e., column) to not exist in the Excel-file being imported. 
 
  

190 rows added 

5 rows updated 

Import completed successfully 
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Appendix A – Key Data Requirements for Formulation Applications  

Core Data Requirements 

Regardless of which model type is used to optimize, each of the following core data requirements 
must be met: 

- At least one Batch/Formula must be included in the Input Set 
- Each Formula must have at least one Item 
- Each Item must have at least one Lot 
- Each Formula must have at least one Constraint 

Note that there are many other data elements that are needed to have a meaningful solution, but 
minimally, the elements listed above must be met for the optimizer to even evaluate the Input Set. 

Specific Data Requirements 

Data required for many of the tables varies by the model that will be used to optimize.  The 
following table shows the fields whose input values are used or considered by each of the 
respective model types.  Refer to the respective tables for detail on how the data fields may 
interact or for acceptable values: 

Table – Field 
Single Product 

Sequential Single Product 
Multi-Product 

Production Planning 
Lot Allocation 

Procurement Planning 

   

Input Set   

- Start of Planning 
Period 

 Yes 

- Number of Intervals Yes  (1) Yes 

- Interval Type Yes  (Single Period) Yes 

- End of Planning 
Period 

 Yes 

Input Set Products   

- Scheduled Date  Yes 

- Location  Yes 

Lots  On-Hand Lots  Procured Lots 
(Procurement Planning) 

- Available Date  Yes  

- Expiration Date  Yes  

- Weight Available Yes Yes Yes 

- Location  Yes <must be blank> 

- Supplier  <must be blank> Yes 

- Minimum Purchase   Yes 

- Minimum if 
Purchased 

  Yes 

- Maximum Purchase   Yes 

- Earliest Available 
Date 

  Yes 

- Latest Available Date   Yes 

- Unlimited Quantity Yes Yes Yes 

 


